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The 25 Best Free Photoshop Plugins for Photographers.

Photoshop is, indeed, a powerful tool for editing your photos. But if you want to make sure you maintain consistency in your editing workflow or if
you want to speed up the editing process, you’ll need a quality Photoshop plugin.

From applying HDR effects to converting your images to black and white, there is a plugin for every situation, and in this post, we’ve gathered the
best free Photoshop plugins for photographers.

You might also like this collection of free Photoshop plugins for UI designers.

HDR Sharpener Tool.

This tool makes it easy to create HDR-like effects for your images instantly. It will increase the dynamic range of the image and sharpen it in a non
destructive manner.

KinemaPhoto-LITE.

This Photoshop extension makes it easy to unleash your creative potential creating cinemagraphs, GIFs, and other animations. You will be able to
create still images from a video layer, create video loops, and more.

CineStock Photoshop (Envato Elements)

This resource gives you the 18 Photoshop actions to simulate the look of cinematic effects popularized by movies and television series. Each action
contains all the adjustment layers and is non destructive so you retain your original.

Photo FX Photoshop Plugin.

Gain access to 18 cool effects and filters to use when editing your images. The plugin includes 8 different filters, 9 different light leak effects, and a
film grain effect that you can use immediately.

Tint and Black & White Conversion Plugin.

This Photoshop tint plugin is perfect for adding tints to an image for artistic effect. Quickly apply a range of color tones or convert images into
black and white for that retro feel.

Skin Beauty Retouch Plugin.

Easily retouch skin tones with this plugin. With a 1-click application you can make any skin tone free of blemishes and look beautiful. This is a
handy plugin when you want to make all your photos look their best.

Double Exposure (Envato Elements)

This Photoshop plugin gives you access to a set of 4 actions that simulate a double exposure effect. This effect works well with other Photoshop
actions you may have installed.

Enhanced Sub-Pixel Diffusion.

Thanks to this Photoshop plugin, you’ll have the power to perform sub-pixel diffusion effects. With sub-pixel diffusion you can apply this effect
when and where you would need to apply antialiasing.

Generate Ascii Art.

This Photoshop plugin makes it easy to convert your images into an ASCII stylized image. ASCII art works by mapping heavier toned ASCII
characters to dark areas of your image and lighter toned ASCII to the lighter areas. Not all images will translate well.

Oil Paint Photoshop Plugin.

Convert any of your image into a realistic painted look without all the effort. In one click you can transform any image with a resolution size of
1000 to 4000 pixels.

Anaglyph Photoshop Actions (Envato Elements)

Save time, money and effort with this Photoshop resource. You will be able to quickly apply one of 4 basic anaglyph or 11 experimental anaglyph
actions with a simple nondestructive click.

Generate Barnsley Fern Fractals.

With this Photoshop plugin you will be able to create wonderfully looking fractal designs. Generate eye catching patterns in any color with a little
mathematical help and create random fractals or manifest your creative streak with controls for asymmetry and scaling.

White Balance / Highlight Recovery Plugin.



This powerful Photoshop plugin will apply a white balance to your images. This makes your photos brighter and have more contrast. Using images
shot in a RAW format will produce the best results.

Halftone Print Simulation Plugin.

This Photoshop plugin will simulate halftone imagery through the use of dots. The images you create with this plugin can be printed with each color
channel independently or all together. You can lock or unlock the color channels for black and whites or creating masks.

VHS Photoshop Action (Envato Elements)

With this plugin you will be able to quickly apply a glitched or VHS look to all your photos. Simply install the plugin, load your image and click
play on the plugin. You will receive 1 action file, 1 pattern file, 1 file with brushes and instructional PDF.

Lens FX Plugin.

Use this plugin to achieve special effects for all of your images. Choose from a pinch, push, sine variants, concave and convex versions as well as
waves or ripples. This plugin can help you create wonderful pieces of art.

stylize!

Stylize is a wonderful and artistically based plugin that transforms your images into something that looks painted, water colored, or drawn. With
dozens of styles to choose from, this will be a welcome addition to your Photoshop workflow.

Multi Purpose Pixelation Photoshop Plugin.

With this plugin you will be able to make pixel art out of any of your images. This plugin supports an 8 and 16 bit channels with a color channel
mode for professional workflows.

Watercolor Photoshop (Envato Elements)

This Photoshop action can be used to create digital artwork in 1 click. This plugin will generate the watercolor art and multiple layers that you can
further tweak and customize.

Remove.bg Plugin for Adobe Photoshop.

With this plugin you will save time working on backgrounds. Quickly and easily remove the backgrounds, even around challenging edges like hair.
Use the layer mask to quickly remove or restore regions of an image.

Composition Grid Plugin.

This plugin will help you generate a grid that you can apply over your photo for easier editing. Each grid is generated as a separate layer so that
you can apply the theory behind the Rule of Thirds, Golden Ratio, and Dynamic Symmetry.

Generate Randomly Fitted Boxes.

Quickly and easily generate a mosaic of randomly sized boxes out of your images. This is a wonderful way to give your images a whole new artistic
look. The box fitting tool provides control over how many boxes to create, the maximum size allowed, as well as an option to sample color from
the original image or to use custom colors.

Summer Duotone (Envato Elements)

Save time with your image editing workflow with this resource highlighting the summer colors. This resource gives you 20 custom summer duotone
actions to help get your summer design juices flowing.

Variable Channel Inversion Plugin.

This simple but unique plugin allows precise, independent and variable color channel inversion. This will yield impressive results when full control of
each channel is used. Choose colors from 8 or 16 bit channels for your project.

Action Launcher Extension.

If your Photoshop has amassed a large collection of actions and actionsets then you will want to get this launcher. Quickly and easily find all of
your actions, sort them through a favorites selection, as well as run the actions right from the launcher.

Highpass Sharpen Photoshop Plugin.

This Photoshop plugin introduces another high fidelity method of sharpening your images by using highpass frequencies. This is a method used by
professionals in the production industry and a technique favored by professional photographers and photo retouchers alike.

Lens Vibrant Effects (Envato Elements)



With just a click you can apply any of the twenty vibrant filters to make great images that can be used for blog posts, book covers, social media,
and more.

PolarProjection Generator.

This polar projection plugin turns your panorama pictures into their own little worlds. The plugin takes the pain out of the long process to manually
morph your panorama images into stereographic projections.

Automate Diptych & Triptych Layouts.

Tych Panel is an extension that automates the creation of triptychs and diptychs. It also offers an easy way to set up your rows and columns for
your image placement.

Stock Photo Site Photoshop Plugins.

Use this article to fill up your creative library with useful Photoshop plugins that will save you hours during the photo-editing process.

Related Posts.

Related Tags.

RSS Newsletter.

Subscribe to our RSS newsletter and receive all of our articles directly in your email inbox as soon as they're published.

25+ Best Free Photoshop Plugins 2021.

Photoshop Plugins are one of the hidden features of the photo editor that many designers fail to notice. We created this list of the best free
Photoshop plugins to show you how plugins can help improve your workflow.

When it comes to graphic design, the way you organize your Photoshop app interface and plan the workflow plays a key role in efficiency and
productivity. That’s why every designer should experiment with Photoshop plugins as they can permanently improve your workflow.

With a single plugin, you can create gradients instantly. Or sharpen an image with just a few clicks. Or even find high-quality stock photos without
ever having to switch to Chrome.

Explore our collection of free Photoshop plugins and you’ll find a whole new world of useful tools.

The Ultimate Designer Toolkit: 2 Million+ Assets.

Envato Elements gives you unlimited access to 2 million+ pro design resources, themes, templates, photos, graphics and more. Everything you'll
ever need in your design resource toolkit.

Graphics.

Icons, Vectors & More.

Fonts.

Sans Serif, Script & More.

Presentation Templates.

PowerPoint & Keynote.

How to Install Photoshop Plugins.

If you’re new and not sure how to install Photoshop plugins, simply follow the steps below to get started.

Step 1: First, download the plugin file. It’ll come as a ZIP file Step 2: Extract the contents of the ZIP file Step 3: Create a folder on your computer
to store all Photoshop plugins and copy your downloaded plugin files over to the new plugins folder Step 4: On Photoshop, go to the Edit menu
and then to Preferences >> Plugins Step 5: Check the tickbox that says “Additional Plugins Folder” and then locate your new Photoshop plugins
folder on your computer and click OK Step 6: Restart the Photoshop app to enable the new plugin.

To enable some plugins, you’ll have to navigate to the Filters menu and locate it there.

Some Photoshop plugins come with setup files. Those can be easily installed by running the installation wizard. When downloading plugins from
Adobe Exchange, make sure to have the Creative Cloud app installed on your computer to integrate the plugins with Photoshop.

Find a plugin from the list below to improve your workflow.



Pexels Photoshop Plugin.

Pexels is one of the biggest free stock photo sites on the Internet. It has a massive collection of high-quality stock photos you can use in your
designs for free of charge. This is the official Photoshop plugin for Pexels. It allows you to access its entire photo database directly from Photoshop
to easily find and use photos without having to leave Photoshop.

Layers Control 2.

Only designers know the pain of having to manage dozens of layers in a PSD file. It’s easy to get lost in a sea of layers when you forget to organize
them well. Sometimes, you don’t even have the time to keep layers organized. This plugin will come in handy on those occasions. The plugin
makes layer management easier by allowing you to easily organize and clean your layers palette in a simple way.

HDR Sharpener.

Adding HDR effects into regular photos can be tough. But, with this free Photoshop plugin, you can add HDR effects with just one-click. It even
has a slider to adjust the strength of the effect to match your photos.

EasyMockups.

EasyMockups is a high-quality Photoshop extension that allows you to create stylish mockups for showcasing your app screens and designs. The
extension is compatible with Photoshop CC 2015 and higher. And it lets you choose from 10 mockup designs with lots of customization options.

Skeuomorphism.it.

If you use Photoshop for UI design, this plugin will definitely come in handy. It allows you to easily transform the look of your UI designs and
objects by giving them a flat design look inspired by the popular Skeuomorphism design concept.

Seamless Textures Generator.

Patterns and textures are also among the most used resources in Photoshop. Usually, you have to download such resources from third-party
marketplaces. But, with this plugin, you can create your own seamless patterns. The plugin lets you generate seamless patterns and textures from
your own images with just a few clicks.

Pixel2Vector Converter.

This free plugin is a must-have plugin for every designer and you’ll immediately fall in love with it. The plugin basically lets you generate vector
shapes from ordinary pixel images. This is incredibly useful. For example, you can use it to copy text from an image and resize it without making it
look pixelated.

Highpass Sharpen.

This is another Photoshop plugin that allows you to easily sharpen images without having to go through dozens of adjustment tools. It includes
several advanced options for adjusting and customizing the sharpening effect as well.

Lens FX.

Lens FX is a useful plugin for creating simple distortion effects in Photoshop. The plugin comes with a set of different effects you can use to add
various types of distortions to your images.

Ink is a useful free Photoshop plugin you can use to keep your PSD files well-organized. It’s especially useful for designers who sell PSD
templates. The plugin allows you to document the layers of PSD files and templates so that they are easy to find and discover their uses when
sharing your files.

If you’re a designer who works with iOS and Android app designs, this free plugin will be quite useful to you. The plugin allows you to easily label
the layers and export them as iOS or Android assets almost instantly. A really useful plugin that will help save a ton of time when exporting design
files as assets.

Tych Panel 2.

This is a free Photoshop plugin you can use to easily and automatically create diptychs and triptychs. Or, in other words, create photo collages. Of
course, the plugin is more complex than a photo collage tool and has more advanced composition systems to help you create images for photo
albums and even social media.

Skin Beauty Retouch.

Photo retouching is one of the most time-consuming tasks of the photo editing process. With this free Photoshop plugin, you can make it less
tedious. The plugin allows you to easily enhance portrait photos with basic skin retouching.

RealLookLongShadow Panel.



You’d be surprised to see how many designers still use layer style effects to add shadows to objects. You’d be better off using this free plugin
instead. It allows you to create realistic shadows for your objects with ease. And it makes shadows fully customizable as well. So that you can go
back and edit the shadow whenever you want.

Watermark for Adobe Photoshop CC.

Tired of adding watermark to photos? Usually, you have to add watermarks to photos one by one. It could take ages to process big batches of
photos. This free plugin allows you to easily add watermarks to photos with just a single click. It works with both text and image watermarks.

Free Retouch Panel.

Photographers will find this free plugin quite useful, especially for processing portrait photos. This plugin adds a new panel to the Photoshop user
interface to help you retouch photos without an effort. It includes multiple adjustments and options for enhancing and improving portrait photos.

Comic Kit.

Comic artists and illustrators will certainly love this free Photoshop plugin as it can generate many creative patterns with ease. You can use it to
quickly generate patterns used in comics and cartoons.

Slimming File.

When working on large projects, your PSD files could end up having enormous file sizes. This free plugin makes it easier for you to handle all those
large files. It helps cut down file size by removing empty and unused layers as well as rasterizing smart objects. You can also lock certain smart
object layers if you want them to skip the automatic rasterization.

QuickOut.

Even though this plugin is not 100% effective, it’ll be quite useful in many occasions. The plugin lets you instantly remove the background from
images without removing the shadow. It may not work with all kinds of images, but it’s a useful plugin that’s worth checking out.

Griddify.

Griddify is a lightweight plugin made for designers who work with grids. The plugin allows you to easily create custom grids to manage your canvas
and workspace more easily.

Halftone.

This plugin is great for crafting unique designs from your ordinary images. It simply generates halftone patterns from images. The plugin offers lots
of adjustments for customizing the halftone effect. You can even use it to create old-school comic halftone effects as well.

Channel Modifier.

This is a plugin made specifically for designers who like to experiment with different features in Photoshop. The plugin lets you play with color
channels in Photoshop to create weird effects.

SuperPNG.

If you’re a designer who works with lots of PNG files, this plugin will come in handy. It allows you to compress PNG files to save file size without
affecting the image quality. The plugin is a few years old and it hasn’t been updated in a while. It’s unsure if it’ll work with the latest versions of
Photoshop.

Swatchy.

Swatchy is a simple yet useful Photoshop plugin that helps you organize your color swatches. The plugin lets you create folders to keep your color
swatches organized and easy to find. You’ll be able to create different folders for different color schemes.

Make sure to check out our best Photoshop actions collection to further improve your workflow.

Become a Member.

Join our 30,000+ members to receive our newsletter and submit your design work.

Free Photoshop Filters and Plug-Ins.

Customize Photoshop with hundreds of plug-ins and filters.

Tweet Share Email.

Best Apps Payment Services.

Change the look and feel of your Adobe Photoshop images with these free Photoshop filters, and improve your working environment with these



free Photoshop plug-ins. Filters and plug-ins are a great way to customize your Photoshop experience quickly.

Photoshop filters are image effects or settings used to change the way a picture looks, and plug-ins are extended features like rulers or guidelines
that aren't included with Photoshop by default.

You can also use free Photoshop actions, templates, shapes, brushes, and textures to change your Photoshop images.

Not sure how to install Photoshop plug-ins and filters? Skip down to the bottom of this page for help.

Adobe's Free Photoshop Plug-Ins.

Many are rated, from one to five stars.

Easy to search for and find what you need.

Requires a free Creative Cloud program.

Must create an Adobe account if you don't have one.

What better place to get free Photoshop plug-ins than the Adobe website? You can sort the hundreds of free resources by title or rating as well as
by newest added or most popular. You'll find extensions, actions, and other things.

The Adobe Photoshop plug-ins are installed differently than the others on this list. You must have a free Adobe account and the Creative Cloud
program installed to use the plug-ins.

To find only the free Photoshop plug-ins at the Adobe website, choose Photoshop from the filtering area on the left, and choose the Free filter on
the right side.

Mehdi's Free Photoshop Filters.

Thorough explanation of each plug-in with examples.

Dozens of plug-ins available.

FAQ page and the ability to contact Mehdi for support.

Dated but useable interface.

Windows only. Not for macOS.

Mehdi offers dozens of free Photoshop filters. Each download page has a thorough explanation of the filter as well as screenshots.

Kaleidoscope, Projection, Sorting Tiles, Blots, Weaver, and Contrast Balance are just some of the free filters you can download here.

The Plugin Site's Free Photoshop Filters.

A single download saves time.

Fast access without layers of menus.

Doesn't update often.

Harry's Filters (formerly VideoRave) is a download at The Plugin Site that lets you get around 70 image effects for Photoshop in one download.
The Plugin Site has other downloads as well, including Photoshop actions.

On the download page, scroll past the commercial downloads to find the free options. When you're ready to download something from this
website, fill out the download form to get the download link in your email.

Lokas Software's Free 3D Shadow Filter.

A broad range of shadow effects.

Site design is difficult to follow.

Lokas Software has only one free Photoshop filter, called 3D Shadow. We include it in this list because while Photoshop has a text shadowing
feature, we find this one to be more useful.

Use it to adjust the blur, axis and offset angle, zoom, and color, as well as select a preset shadow effect, such as Cast in Front, Flat Faint, and
Rear shadow.

RichardRosenman.com's Free Photoshop Plug-Ins.



Easy to browse through available plug-ins.

Thorough explanation of each plug-in's function.

No new releases in years.

RichardRosenman.com has one page of free Photoshop plug-ins, including Diffuse, Box Fitting, Pinch, Pixelate, Solid Border, and Evaluate.

The plug-ins you'll find at RichardRosenman.com have a short description and a sample picture to show you what the plug-in does.

All downloads are direct links to ZIP files.

How to Install and Use Photoshop Filters.

After you download a Photoshop filter, copy the 8BF file to the Photoshop Filters folder to install it. On Windows computers, that folder usually
resides here:

C:\Program Files\Adobe\Adobe Photoshop (version)\Plug-ins\Filters\

If putting the Photoshop filter in that folder doesn't work, try this one:

C:\Program Files\Common Files\Adobe\Plug-Ins\CC.

Access your installed filters from the Photoshop Filter menu.

However, some Photoshop filters are installed through an EXE file so that it installs like a regular program. In those instances, you don't need to
copy any files into any program folder. Instead, open the EXE file like you would any application.

How to Install and Use Photoshop Plug-Ins.

Photoshop plug-ins are ZXP files that must be installed using Adobe Extension Manager (unless it downloads as an EXE program file). Choose
Install to browse for the ZXP file.

Installed plug-ins can be accessed from the Photoshop Window > Extensions menu.

10 Best Photoshop Plugins (Free and Premium) for 2021.

Ready to become a Photoshop power-user? Good, because the Photoshop plugins, add-ons, and extensions we list in this post will supercharge
the already impressive capabilities of Adobe’s preeminent software.

Yes, Adobe Photoshop CC is outstanding on its own. But there are plenty of features that users wish they had access to but don't. Plus, there’s no
way that Adobe could’ve packed in every add-on, extension, or plugin and still kept the software at its current price point.

Lucky for you, not all of the plugins you’ll read about today cost money!

That’s not to say that you should only look for free plugins. Some of the premium Photoshop plugins we list are so good, you’ll want to buy them
immediately — if you’re really serious about upping your Photoshop game, that it. But before we get into the best free and premium Photoshop
plugins for 2021, let’s quickly cover how to install Photoshop plugins:

How to Install Photoshop Plugins.

Here’s a simple way to install Photoshop plugins:

Open Photoshop. Select Edit from the dropdown menu, and select Preferences > Plugins. Check the "Additional Plugins Folder" box to accept
new files. Download a plugin or filter to your desktop. Open your Program Files folder and select your Photoshop folder. Open your Plugins
folder, found inside your Photoshop folder. Drag your new Photoshop plugin from your desktop into the Plugins folder. Reopen Photoshop and
find your new plugin under Filters in the dropdown menu.

Now that you know how to use Photoshop plugins, let’s take a look at some of the best free and premium Photoshop plugins available in 2021.

Best Free Photoshop Plugins.

As the old saying goes, “the best things in life are free.” Of course, these plugins may not be “the best things in life” (unless Photoshop IS your life),
but they’re pretty good and can be used completely free of charge.

1. Camera Raw.

Camera Raw is a Photoshop plugin that lets you edit and enhance raw files from your digital camera, along with JPEG and TIFF files. If you’re
unfamiliar with a raw file, it’s simply the unprocessed picture data from your digital camera.

With the Adobe Camera Raw plugin, you can sharpen raw pictures, set white balance, and adjust the contrast among many other features.



The best part is, Camera Raw uses non-destructive editing, which means it doesn’t alter the original picture file in case you want to revert back to
it after you’ve finished editing. This plugin has been a must-have tool for photographers and should definitely be in your editing toolkit.

2. Ink.

Ink is one of the best free Photoshop plugins on this list. It allows designers to create useful mockups and user interfaces, which lets an
inexperienced Photoshop user — like a developer, for example — understand the design elements within a coding framework.

In other words, Ink makes it easy to communicate your design by generating full specs such as text formatting, layer styles, and dimensions.

This is especially helpful if you have to hand off work to a developer on GitHub and want to ensure that he or she will accurately interpret your
design. Fortunately, this handy app can be accessed and used for the low price of zero dollars!

3. Texture Anarchy.

Texture Anarchy is a Photoshop plugin that offers its users a library of different filters and textures to edit their photos with. What sets it apart from
similar plugins like ON1 Effects is the fact that the textures it produces are based on fractal noise, which makes it easy to create natural images like
fire, smoke, or marble.

If you're new to Photoshop, or photo editing in general, and the above paragraph sounds confusing, don't worry. Texture Anarchy is actually pretty
easy to use. It even comes with presets to help you get started on the right foot.

4. FlatIcon.

FlatIcon is a Photoshop plugin that will give you access to thousands of free vector icons, which can be downloaded in multiple formats such as
SVG or PNG.

With FlatIcon installed, you can search through its database of icons from within Photoshop and insert them directly into your design panel. What
kind of icons are we talking about? Just about anything! FlatIcon has millions of icons available for use. Now, FlatIcon does have thousands of
icons available for free. But, they require attribution to use legally. Alternatively, you can sign up for a FlatIcon subscription and get access to many
more, attribution-free icons and priority support. FlatIcon plans start at $8.25 a month.

Best Premium Photoshop Plugins.

As Warren Buffett once said, “Price is what you pay. Value is what you get.”

While these premium Photoshop Plugins come with a price tag, they pack a serious punch and provide artists, photographers, and casual
Photoshop users alike with tons of value. Here are the six paid plugins that we believe will make the biggest impact on your output and workflow:

1. RH Hover Color Picker.

RH Hover Color Picker is a Photoshop color plugin that isn’t ugly or cumbersome (unlike the color picker built into Photoshop) and gives you
more control over the colors you pick with its set of customizable sliders.

It’s aptly named the “Hover” Color Picker because it only reveals itself when you hover over its minimized version, and then conceals itself once
you’re done using it. Convenient!

RH Hover Color Picker is really easy to use and will speed up your Photoshop workflow dramatically. Luckily, it can be had for just $16. Make
the process of picking colors much easier and more enjoyable with this premium plugin.

2. ON1 Effects.

ON1 Effects is a Photoshop plugin that gives you access to hundreds of built-in presets, filters, LUTs, textures, and borders. These effects can
then be combined, blended, and otherwise customized to create a unique look for each of your photographs.

If you’re looking for an all-in-one tool for adding complex effects to your photos, ON1 Effects is the solution you need. Get it for a one-time
payment of $59.99.

3. Fluid Mask 3.

Fluid Mask 3 is a Photoshop plugin that can be used to remove backgrounds and perform cutouts — a necessity for most modern photographers
and graphic artists.

Masking, i.e. making part of a layer invisible, is a delicate and often difficult process. Fluid Mask 3 is one of the few plugins that will give you a
clean and accurate mask, especially with problem areas like hair and fur.

Even though Fluid Mask 3 costs $99, its ability to detect edges, blend layers, and simplify painstaking tasks makes the high price tag worth it.
That's why big companies like Disney, NBC, and Macy's use it on a regular basis.

4. Noiseware.



Noiseware is an award-winning Photoshop plugin for noise reduction. Noise is the colorful grains or discoloration found in Photographs that give it
a splotchy or blurry look. In simple terms, it's the part of your photographs that you usually don't want.

Noiseware removes graininess from images and sharpens them simultaneously, allowing you to clean up your photos quickly and professionally.

Although it costs $79.95, it justifies its premium price tag with unparalleled targeted noise reduction that few other plugins can even come close to
matching.

5. PortraitPro.

Have you ever taken a picture of yourself and thought, "Oh no, is that what I really look like?" Don't be ashamed, it's happened to all of us. The
camera can be quite unkind at times. When you're not happy with the results of your latest portrait, get PortraitPro.

PortraitPro is a Photoshop plugin that helps users retouch and edit portraits without giving them a “Photoshopped” finish. It prides itself on being a
software built to enhance human beauty without making faces look plastic or fake.

PortraitPro accomplishes this feat by using a slider interface to sculpt and refine a subject’s features. Use this editing tool to smooth skin, apply
makeup, correct poor lighting, change hair color, and more.

Whatever aspect of your portraits that you need to adjust, PortraitPro can help you do it for a one-time payment of $89.90.

6. Machine Wash Deluxe.

Last, but certainly not least, we have Machine Wash Deluxe, which is a Photoshop plugin that adds scratchy, weathering effects to your photos.
When you want your images to have that cool, retro vibe, Machine Wash Deluxe is the app you need.

The plugin comes with over 3,500 presets, which can be used to texturize and alter photographs in thousands of different ways and make them
look old, vintage, or otherworldly.

Machine Wash Deluxe is an incredibly fun plug-in to play with and will help you create unique images that stop viewers in their tracks. It will cost
you $99 to access. But if you have a little extra cash to spend, you’ll love the abstract photo transformations you can make with it.

Honorable Mention: CloudApp.

CloudApp isn’t technically a Photoshop add-on, plugin, or extension — at least not yet. But it will help you get the “raw materials” you need to
create great photos.

Our free screen recorder lets you record videos and take screenshots on mac and win of virtually anything, edit them in Photoshop, and then pass
them on to your developer. If your developer has questions, they can take a screenshot of your finished product, annotate it, and send it back to
you. You’ll then be able to comment on those annotations and easily make the required changes.

CloudApp is available as a Mac App, a Windows App, and as a Chrome Plugin. This means that just about anyone can create visual content from
their desktop device of choice!

If you want to streamline your Photoshop workflow and easily create the stunning visual materials needed to get the job done, consider signing up
for CloudApp — it's free and it integrates with Adobe products, Slack, and other workflow tools.

In Conclusion:

There you have it, the 10 best photoshop plugins in 2021. If you regularly use Adobe's legendary software, these tools will help you supercharge
your workflow and create better visual content. Now you just have to decide which ones you want to use! ​

And don't forget about CloudApp! Our visual communication software is a great way to create the raw materials you need to edit inside of
Photoshop. From screenshots to annotated images, use CloudApp to capture anything on your computer screen. Get started today for free!

22 Best Photoshop Plugins for Photographers 2021.

Photoshop boasts countless different possibilities - no wonder it’s an all-time favorite tool amongst designers and photographers. Though, to
unleash the full potential of Photoshop, you might need some extra help… This is where plug-ins fit into the picture. The following are 22 of the
best plug-ins, in no particular order, that you need to add to your to-download list today.

If you often work with raw photos, Luminar AI is a plug-in that you’d find rather helpful. With the help of AI and preset effects, it makes editing
jobs like object removal and masking significantly easier. It’s available for both Lightroom as well as Photoshop.

If you’re using Photoshop CS5 or higher, you’ll love the Photoleumr 3 plug-in. This automatic photo editor uses AI to make your photos pop.
Why do all the hard work, when there’s a plug-in that was created for this job? From recovering color to correcting your exposure, Photolemur 3
will make your photos just as magical as your special moments.

The RH Hover Color Picker is ideal for designers and artists who want better color control. Published by Rico Holmes, this plug-in boasts color
sliders that you can customize giving you much better control. It’s definitely better looking and less awkward than the color picker offered by



Photoshop.

If you want to transform your ordinary photo into the one with the Double Exposure effect, you should have a closer look at this universal bundle
consisting of 26 cool actions. There are tools producing Color Double Exposure, Dispersion, Splashes, Silhouette and Advanced Double
Exposure effects in a matter of seconds. To get even more flexibility while editing your pictures, you can use any of 13 Photoshop brushes included
in the pack. The cost is reduced to $50.

If need to include rich textures into your designs, Texture Anarchy will help you to get the job done. In addition to the wide range of filters that you
can use for your designs, it also enables you to create fractals.

Photographers will love this easy-to-use plug-in. With the help of ALCE 3, you can add more depth to your photos by enhancing the contrast.
What makes it so great is that it’s much easier to use than Photoshop’s unsharp mask filter.

Designers who often make use of grids when they’re creating layouts will find the GuideGuide plug-in oh-so-useful. It allows you to save your
preferences which means that you will save loads of precious time whenever you want to access it again. In addition to enabling you to create
extremely accurate grids, you can also use negative margins with the help of GuideGuide.

To make viewers look at your photos again and again, you need to give them an unusual feel. With this idea in mind, FixThePhoto has created a
new collection of Low Poly Photoshop actions and supplemented them with 3 brushes and 5 nice-looking patterns. You can get all these tools just
for $24.

Blow Up 3 will blow your mind. Thanks to this practical plug-in, you can create piercing sharp enlargements. As a matter of fact, the algorithm that
this plug-in uses is better than the filters that Photoshop boasts. Next time that your client emails you a low-resolution photo, Blow Up 3 will see to
it that your project will not be blown off course.

If you work with PNG files often but don’t have access to the latest version of Photoshop yet, you’ll love the SuperPNG plugin. With the help of
this plug-in, you can gain better control over the exporting process. Battling to render your PNG files will be a thing of the past!

Let’s face it, the 3D process can be challenging, even for experienced designers. Though with 3D Invigorator in your arsenal of design tools, you
can create 3D elements and polished final renders without breaking a sweat. This Photoshop plug-in boasts an easy-to-use object editor that will
make it a lot easier to draw and edit your shapes.

Thanks to the ParticleShop plug-in for Photoshop, you can now play around with Corel Painter tools. From fabric to fur, ParticleShop boasts over
10 brushes! These brushes will boost your productivity and help you to take your creativity to the next level.

Machine Wash Deluxe is definitely no washout! With the help of this Photoshop plug-in, you can add a realistic scratchy weathering effect to
images. It works especially well with typography. So, if you want to add an attractive aging effect to design, this is the tool for the job.

If you’re serious about digital photography, B&W Effects is an essential plug-in. What makes this plug-in so great is that it lets you create black
and white photos that really stand out. Thanks to its conversion engine, you can transform your colored photos into magnificent monochrome pics
that have just the right texture and tone.

Dream Suite Ultimate is one of the most comprehensive plug-ins for Photoshop that’s available on the market. It boasts an impressive range of
effects that include borders, textures and tonal correction to mention only a few. What makes this plug-in so great is that it gives you access to
many options in a single plug-in which means that don’t have to buy countless different plug-ins.

If you’re in need of a metal texture to magnify your photo, the Texture Tools Industrial Photoshop plug-in offers everything that you’ll need. With
50 metal textures on offer, designers and artists can first put the metallic filters to the test before reaching for their credit card. What’s more, the
plug-in also allows you to manipulate the texture so that it fits your photos.

Designers who regularly have to work with Shutterstock can make their workflow more efficient with the help of the Shutterstock plug-in. In short,
it offers you direct access to the countless stock images that the Shutterstock library boasts. This means that while you’re working inside of
Photoshop, you can quickly search Shutterstock’s complete library, select and insert. Voila!

Those inspired by watercolor paintings, will definitely appreciate this bundle designed by professionals. It includes 3 watercolor Photoshop actions,
14 brushes and 3 patterns aimed at giving your photos that specific look and mood. These actions are compatible with all Ps versions and cost
only $35.

Although the functionality of this plug-in is very limited, what it does it can do brilliantly. It’s ideal for graphic designers who need to create a
realistic fold and page-turn effects. So, if you regularly work with ebooks, get PageCurl 2 to promote your page-turner.

If you need access to a large database of free vector icons, FlatIcon will make sure that your designs will not fall flat. With the help of this
Photoshop plug-in, you can search for icons within Photoshop that you can download in different formats including PNG, SVG, and PSD.

Published by Alien Skin, Eye Candy is a well-known plug-in among Photoshop users. It boasts a really impressive collection of effects which you’ll
find quite handy for plenty of projects. If you find that the effect is too obvious and boring, just fiddle with the default settings to create a better
effect. This plug-in might just be a lifesaver next time that you’re battling with a tight deadline.

Another great plug-in that will save you a lot of time is Subtle Patterns. By adding Subtle Patterns to your plug-in list, you get access to a library of



tileable, textured patterns. It’s oh-so-convenient to use as you simply click on the thumbnail of the pattern that you want to use and it will be
applied to the layer that you’re currently working on.

Calling all portrait photographers! If you’re searching for a plug-in that can help you to smooth skin tone and remove imperfections without
removing skin texture altogether, this is the tool just for you. What makes this plug-in so great is that it’s compatible with Aperture, Photoshop as
well as Lightroom.

Fixel Edgehancer is the perfect plug-in for those who are just starting to use Photoshop. In short, it’s a quick way to emphasize the edges without
increasing the surrounding pixels’ contrast.

With the help of these popular plug-ins, you’ll be able to turn Photoshop into an even more powerful tool. So, which one of these 22 plug-ins will
become your favorite new tool?
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